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What is Window Shopper?

How many times has this happened to you at the grocery?  You're almost 
through... just picked up the bread and tomatoes and there it is at the bottom of 
your list! Toothbrush.  Now you must go all the way back to the other side of the 
store and  pick up the misplaced item.  You can waste a lot of time and steps this 
way.

Window Shopper is designed to eliminate the frustration of a jumbled list, saving
you time and money.  Money?  Yes!  Because Window Shopper allows you to 
comparison shop between up to five stores and automatically selects the lowest 
price.  It will also save you time, not only in the store but also while preparing 
your shopping list.  It would be almost impossible to hand write a shopping list as 
fast as you can prepare one with Window Shopper.

A bit of history...

Window Shopper is the logical outgrowth of Shopper's Assistant, a DOS 
program of similar capabilities.  Shopper's Assistant pioneered the concept of a 
store map to keep your list organized and easy to deal with.  It evolved through 
several versions, each gathering new and enthusiastic users....users who kept 
making suggestions that made the program better and better.  As Microsoft 
Windows (tm) became more popular, we had numerous requests for a Windows 
version of Shopper.  At the same time, we had some ideas of our own for making 
the program easier to use and more flexible.  The result is the program you are 
about to install.

What is included...

The distribution disk or archive file should contain the following:

README.1ST A plain text file describing last minute changes, a brief 
explanation of the installation procedure, and how 

to view 
or print this documentation file.

WSHOPDOC.WRI The file you are reading right now.  This is a Windows 
Write file and shoul be viewed or printed using 

Write.
WSHOPPER.EXE The executable file for Window Shopper.  
SHOPPER.HLP The on-line help file for Window Shopper.  This is a plain 
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text file, not an official Windows help file 
(Microsoft wants an arm and a leg for the tools to 
create real help files!)  Even though this is a plain 
ASCII text file, you should not attempt to edit or 
otherwise modify it.
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VBRUN100.DLL Window Shopper is written in Microsoft Visual Basic and 
requires the same runtime support file that all VB 

programs use.  If you already have this file, there is no
need for a second copy.  Just make sure it is in a 
subdirectory on your system that is named in a PATH
statement.

Installing Window Shopper

To install Window Shopper on your system, you must perform the following 
steps.  Sorry...there is no fancy install or set up program.  We could not sell it for 
only $20 if we had all those frills!

1. Create a subdirectory and copy all of the files from the distribution disk.  
A good choice for a name would be C:\SHOPPER, although this is certainly 

not mandatory.

2. Make sure the VBRUN100.DLL is in your Windows subdirectory or in 
another subdirectory named in a PATH statement. 

3. From the Program Manager screen of Windows,  make the program group 
you wish to contain Window Shopper the current group, then 

select File, New from the menu.

4. Indicate that you want to add a Program Item and press OK.

5. Type the name of the program:  Window Shopper.
Type the name of the executable file:  WSHOPPER.EXE
Type the path of the subdirectory you created in step 1.
Press OK.  WSHOPPER.EXE contains its own icon, so there is no need to
select another.

Note that step 5 assumes you have Windows  3.1.  If you are using 3.0, give the 
full path name of the executable file, i.e. C:\SHOPPER\WSHOPPER.EXE.
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Screens and Functions

This is the main screen for Window Shopper.  From it you select all other 
actions.
Each of the choices on the menu bar opens a list of from 2 to 4 secondary items.

(By the way...I'll bet you hate that ugly registration reminder.  So do I.  And for a 
mere 20 bucks I'll tell you how to make it go away!)

Here is an outline form of the menus and items on them:

File
Print

Shopping List F5
Fridge List F6
Store Map
Master List

Exit Ctrl+X
Item

Clear Selections F3
Select Items F4
Review List
Maintain Items

Map
Maintain Map
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Re-Map Stores
Options

Store Names
Register

Help
General Help F1
About Window Shopper
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File Menu

The File menu contains only two choices, Print and Exit.  There are no Open and 
Save commands as found in typical Windows programs.  This is because Window
Shopper opens the files it needs automatically when it begins and saves them 
when it terminates.  There is also no Print Setup or Printer Select as found in most
Windows programs.  Microsoft Visual Basic does not give the programmer a way 
to offer this option.  Therefore, all printing is done to the default printer.  If you 
wish to use a different printer, use the Windows Control Panel to change the 
default printer before starting Window Shopper.  All printing is done with  the 
default font and size of printer for your printer, so virutally any printer should be 
OK.

The Print choice gives a list of four different reports that may be printed.  The first
two, Shopping List and Fridge List, are used each week and have shortcut keys 
available.  We will describe each of the reports in detail later in this document.

The Exit choice also has a shortcut key, Ctrl+X.  You may also exit by using the 
standard Windows control box, either as a menu or by double-clicking.  In any 
case, Window Shopper saves your work before exiting.  In fact, the only way 
you could possibly not save your work is to lose power or reboot the computer in 
mid-session.

Item Menu

The first choice on the Item Menu is Clear Selections.  This is used each week to 
clear the previous choices and begin a shopping cycle.  You will be asked to 
confirm that you really want to clear the selections to prevent accidental erasures.
Because this is a frequently used option, it has been assigned the F3 key as a 
shortcut.

(Notice the sequence of the shortcut keys.  After the initial setup period, a normal 
session of using Window Shopper can be accomplished by using only the 
function key shortcuts.  F3 to clear the list.  F4 to select the items to buy.  F5 to 
print the list.  F6 to print the "fridge" list  or worksheet for the next cycle.)
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The second choice is Select Items.  This displays the following screen:

To select an item you want to buy, find it in the listing on the right side.  This is a 
scrolling list (scroll bars will appear when the list grows beyond 11 items).  Click 
on the desired item and the name and description will appear on the left, along 
with the price in each of your 5 stores.  The store with the lowest price is 
automatically selected.  You may override this choice if you wish.  To keep an 
item from being suggested for a particular store, leave the price at zero in that 
store.  Tab from the item list to the Quantity box or click in the box with the 
mouse.  Enter the quantity to buy.  Tab again to the store selection.  If you agree 
with the selected store, tab once more, otherwise use the arrow keys or mouse to 
select the store.  If you want to use a coupon for this item (the list will be flagged 
to remind you to check for coupon specific requirements and the coupon amount 
will be deducted from the total), tab to the coupon box and enter the value of the 
coupon.  Press or click OK to add the item to your list.

Speed selection!  If you want to buy one of an item, accept the default store and 
have no coupon, you may speed select by double-clicking the item in the item list 
box.  There is no keyboard equivalent for this Windows trick.
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When all items have been selected, press or click Finished to return to the main 
menu.
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You may use the Review List option from the Item menu to see the items you 
have selected and get a rough total for each store as well as a grand total.  These 
total do not take coupons and taxes into account.  The Review List operates like a 
normal Windows scrolling list.  Use the Up and Down arrows, Page Up, Page 
Down, Home and End keys to maneuver in it.  Press Enter, or Esc or click 
Finished to return to the main menu.

The final choice on the Item menu is to Maintain your items.  It presents the 
following screen:

As in the item selection, begin by picking an item from the list on the right.  
Notice that the Change and Delete buttons are not active until you select an item.  
The edit boxes will fill with the information for that item and you may change it 
as needed.  When all edits have been made, press or click Change to write the 
changes to the file.

To add an item, simply start entering the information and then press or click Add. 
The item will be added and the screen will clear for the next operation.  Note that 
the item category is a pull-down list.  Click on the arrow to the right of the box to 
open the list.  Click on an entry to select it and close the list.  With the keyboard, 
use the Alt+Down to open the list, select an entry by using the down arrow to 
highlight, then Alt+Down again to close the list.
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When all edits have been made, press or click Cancel to return to the main menu.  
You may also press Esc to close this screen.

Map Menu

The first choice on the Map menu is Maintain Map.  The following screen is 
displayed:

As with the item selection and item maintenance screens, you begin by selecting a
category from the list on the right.  Click on the entry and the data will appear in 
the edit boxes.  Make changes as needed and click Change.  You must press or 
click Change to write the changes back to the file.

To add a new category, enter the data and press or click Add.  The record is added 
to the file and the screen clears for the next operation.

Press or click Cancel to return to the main menu.

The Re-Map Stores option on the Map menu will be discussed in the "How to Use
Window Shopper" section.
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Options Menu

The first choice on the Options menu is Store Names.  This is normally used only 
during initial set up to enter the names of the stores you shop in and the local sales
tax rates.  There is a separate tax rate for each store.  This is handy for people who
shop in two different tax jurisdictions, perhaps across a county or state border.  
This screen is displayed to change store names:

Simply tab to each field and enter the appropriate information.  Press or click 
Done when all data is correct.

The Register menu choice is used to insert your registration serial number and get 
rid of that nasty reminder on the main menu.  You will only use this option one 
time.  After your serial number is validated and accepted, the choice is dimmed on
the menu and may not be selected.

Help Menu

The General Help will usually be accessed by the Windows-standard F1 key.  This
is context-sensitive and displays the help appropriate to the screen you are using.  
No fancy official Windows hyper-text help here.  The tools to create that stuff are 
outrageous!  

About Window Shopper displays a small screen with the version and copyright 
information.  Also included is my name and address so you can reach me for 
comments, questions, etc. long after you have misplaced all the documentation for
the program! 
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Reports and Listings

There are four reports available from Window Shopper:  the Shopping List(s), 
the "Fridge" list, the Store Map worksheet, and the item Master List.

The Shopping List:

Shopping List for Schnucks 10/4/92  6:03:01 AM
Loc. Item Description Qty. Price Extn Cpn
-------------------------------------------------------------------------------------------------------------------------------
6      *Peas, Canned Green Giant 2 0.89 1.78 -0.35
7        Eggs, Fresh Grade AA Large, 1 doz. 1 0.81 0.81
11  Cokes, Diet 24 - 12 oz. cans 1 5.99 5.99

Total for Schnucks 8.58
less coupons -0.35

------------------
Net Total 8.23

Notice the * to the left of the first item.  This is present because you indicated you
had a coupon for this item.  It is a reminder to check the requirements of the 
coupon, i.e. size, quantity, brnad, type, etc.

The "Fridge" list:

We call it the Fridge List becaue most folks take a magnet and hang this on the 
side of the refrigerator to use as a handy checklist during the week.  As soon as yu
realize you will need something on your next trip to the grocery, check it here.  
The list contains only the item names and a box to check.  It is presented in 3 
columns to get the most items in the least space.  The list is in alphabetic sequence
of the item name.  Here is a small sample:

'Fridge' List for Schnucks 10/4/92  7:13:24 AM
-------------------------------------------------------------------------------------------------------------------------------
[ ] Apples, Red [ ] Fish, Frozen [ ] Peas, Canned
[ ] Bread, Rye [ ] Milk, 2% [ ] Potatos
[ ] Bread, White [ ] Milk, Buttermilk [ ] Tomatos

The Store Map: 

The third report is used as a worksheet to enter the store layouts into the system so
Window Shopper can sort your shopping lists in order of the way you like t shop 
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in each store.  More about this concept in "How to Use Window Shopper" later in 
this document.   Here is a sample of the report:
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Store Map 10/4/92  9:07:25 AM
Product Category Schnucks Wesselman Buy-Low Great Scot Sam's
-------------------------------------------------------------------------------------------------------------------------------
Baby Products    _____   _____   _____   _____   _____
Bakery    _____   _____   _____   _____   _____
Coffee, Tea    _____   _____   _____   _____   _____

The actual report is double spaced to make it easier to write on.  If the location is 
left at zero in a store, the map prints a blank for you to enter an number, otherwise
it prints the number found in the file.

The final report is a master list of your items.  It shows the item name, desription, 
product category, taxable status, and the price in each of the 5 stores.  It is used 
mostly to check your entry work for errors.  

Legal Stuff

Window Shopper is a copyrighted work.  It is not free and it is not in the public 
domain.  Except as specifically noted, all rights to this work are retained by the 
author, Norman O. Morgan.

You are granted the right to install Window Shopper on your system and use it 
for a reasonable period to determine whether it meets your needs.  A reasonable 
period for this purpose is deemed to be 30 days.  If, after that period, you continue
to use the program, you are obligated to make payment directly to the author.

Upon payment, you will receive a registration serial number.  Use the Register 
function on the Options menu to insert this number in the program and remove the
registration reminder from the main menu screen.  Registration brings the added 
benefit of notification of updates and telephone support.  New versions are offered
to registered users first and offered at a substantial discount.

You are encouraged to give copies of Window Shopper to your friends, to upload
it to computer bulletin boards, etc.  Under no circumstance may you reveal to 
another person your registration serial number.

Warranties

None.  Although I have written this program carefully and tested it thoroughly, I 
cannot guarantee that it will work on your system.  Since it follows all standards 
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and does nothing tricky, it should work.  It is up to you to determine if it works 
before paying for it.  There should be absolutely no way Window Shopper can 
interfere with or damage anything else on your system, but under no 
circumstances will the author be responsible for any incidental or consequental 
damages to your system or data.  Use it at your own risk. 
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How to Use Window Shopper

The first step in using Window Shopper is to use the Options/Store Name 
function to enter the names and tax rates for each of the stores you want the 
program to recognize.  

The next step is to identify the categories of merchandise in your stores.  
Throughout this document we assume that the program will be used for domestic 
grocery shopping, but there is no reason it could not be used for other purposes.  
Make a list of all the different kinds of products you find in the store.  Be careful 
that you are neither too specific nor too general in this process.  For example if 
dairy items are found in two distinct areas in one or more of the stores you shop, 
break them down.  For those stores where they are all together, you can simply 
assign the same number to both groups.

Once you have identified the categories of merchandise, enter them in the Map 
Maitenace function.  Do not attempt to put locations on them yet.  When they 
have all been entered, print the Store Map.  Now visit each of the stores and take a
stroll through it in the order you normally shop.  Jot down the order that you pass 
each category.  Hint:  Use increments of 5 or 10 rather than 1 to make it easier to 
adjust later for changes in store arrangement and the inevitable errors and 
omissions.  When you have surveyed each of the stores, Enter the locations into 
the Map using the Map Maintenance once again.

Now start making the list of items you buy repeatedly.  Enter each item in the 
Item Maintenance.  When asked for the product category, you may now select 
from the map you have already entered.  It will pick up the correct location in 
each store from the map.  You do not enter locations directly in each item, just the 
category.

If you change the layout of a store, i.e. change the location numbers, you must use
the Re-Map Stores command to adjust the locations in existing items.  This is 
done quickly and without manual intervention.

If you move an individual item from one category to another, the locations are 
changed during that process and there is no need to Re-Map.

So far you have done a lot of typing, but that is almost all behind you.  This is the 
point where Window Shopper starts to make life easier for you.  Your stores are 
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identified, your categories are determined and your items have been entered.  
Now print a Fridge List and put it somewhere handy.  It is so named because most
folks stick on the side of the refrigerator with a magnet.  Now, as you think of 
items during the week that you will need to buy on your next trip to the grocery, 
check them on the Frdige List.  By Friday evening, you will have most of the 
work of preparing your shopping list already done!
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Just before you make that weekly trek to the grocery...before you join the 
Saturday Safeway Stampede...sit down at the computer with Fridge List in hand.
Start Window Shopper and pick Item/Clear Selections (F3).  Now pick 
Item/Select Items (F4).  The list box on the right is in the same sequence as the 
Fridge List in your hand.  Simply move through the list of items selecting those 
you have checked.  Remember the Speed Select feature:  If you want to buy just 
one of an item, want to buy it at the default (lowest price) store, and have no 
coupon, you may speed select by double-clicking the item in the list.  If you wish 
to check your work, pick Item/Review List to see the items and quantities you 
have selected.  You can make changes from the item select screen if needed.  If 
you accidentally select an item you do not really want to buy,  use the select 
screen to change the quantity to zero.

When all is correct, pick File/Print/Shopping List (F5) to print your list(s) to use 
in the store.  While you are at it, hit F6 or pick File/Print/Fridge List to print a 
blank worksheet for the next cycle of shopping.
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Registration Form

Please register me as a licensee of Window Shopper.  Here is my check or 
money order for $20 (U.S. funds).  Please send me a copy of the latest version on 
diskette, along with my registration serial number.

I need the software supplied on:
[   ] 3.5" diskette [   ]  720K [   ]  1.44M
[   ] 5.25" diskette [   ]  360K [   ]  1.2M

Name: ___________________________________________________

Address: _________________________________________________

          ___________________________________________________

City, State, Zip: ____________________________________________

Phone:  (_____)  _____ - ___________

Mail completed form and payment to:

Norman O. Morgan
313 Lexington Road
Evansville, IN  47710-3724
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